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Disclaimers and Legal Information 
Copyright © 2014 Aimetis Inc. All rights reserved. 
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Document History 
Date Description 
May 8, 2014 Revised 6.12.4.6 Fixed list with issue number correction 

Removed 6.12.4.1 New list issue AIR-20560 
May 7, 2014 Removed 6.12.4 Improvements list issue AIR-20002 
April 17, 2014 Release 6.12.4.6 
April 2, 2014 Release 6.12.4.5 
March 31, 2014 Release 6.12.4.4 
March 21, 2014 Release 6.12.4.2 
March 17, 2014 Release 6.12.4.1 
February 25, 2014 Release 6.12.4 
January 9, 2014 Updated with known issue 
December 18, 2013 Release 6.12.3.1 
October 15, 2013 Important Note Regarding DevicePack and Export Feature 
October 9, 2013 Release 6.12.2.1 
October 7, 2013 Release 6.12.2 
August 15, 2013 Release 6.12.1 
June 24, 2013 Release 6.12.0.1 
June 18, 2013 Change to directory in Known Issue AIR-16867 
June 12, 2013 Release 6.12 
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Release 6.12.4.6 
(Not generally released) 

New 
AIR-22037 Access the Web Client with username, password, and a live video of a specific 

camera ID using URL variables as follows: 
 
http://[SERVERNAME]:50000/Default.aspx?U=jsmith&P=FIY1TQ==&C=7&R=1 
 
where: 

• [SERVERNAME] is the Microsoft® Windows® Hostname or the IP address 
of the Aimetis Symphony Server 

• U= is the User Name 
• P= is the Encoded Password (Generate the encoded password using the 

Aimetis Password Encode Utility located in C:\Aimetis Symphony Install 
folder\_tools\PasswordEncoder.exe) 

 
• C= is the Camera ID to load 
• R= prevents the server from load balancing the request by redirecting the 

request to another server. Not intended production deployments. 
Note: Ensure that each variable is separated by the ampersand symbol (&) 

 

Fixed 
AIR-21939 Images are cleaned correctly 
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Release 6.12.4.5 
(Not generally released) 

Improvements 
AIR-21760 Moroccan LPR module support improved 
AIR-21877 Retrieving edge storage JPEG and historical video for multi-channel AXIS video 

encoders working correctly 
 

Fixed 
AIR-21832 Occasional LPR crashes resolved 
AIR-21878 Redundant storage works better in configurations with slower media 
 

Release 6.12.4.4 
Includes previously unreleased 6.12.4.x patch release updates 
Fixed 
AIR-21823 Alarm times correct and in sync with alarm images 
 

Release 6.12.4.3 
(Not generally released) 

Fixed 
AIR-21716 Scheduler working correctly 
AIR-21748 ALPR working successfully in cases where motion detection chaining is disabled 
 

Release 6.12.4.2 
(Not generally released) 

Fixed 
AIR-21650 Users can access historical data successfully 
AIR-21675 Following storage restoration, correct time values recorded 
AIR-21624 Footage maintained correctly to prevent recording gaps 
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Release 6.12.4.1 
(Not generally released) 

Fixed 
AIR-21431 Rule actions working correctly with Access Control devices in Symphony 
 

Release 6.12.4 
Improvements 
AIR-14974 Warning displayed in client when external storage device unavailable 

 
AIR-20396 2-Way Audio Support for Axis P8221 
AIR-20666 Support for Cyrillic license plate recognition in LPR engine 
AIR-20725 I/O devices merge correctly during server merge 
AIR-20756 Improved SDK documentation 
AIR-20852 SDK documentation now accessible from Windows Start Menu list of Aimetis 

Symphony programs list 
AIR-20922 Auto detection timeout increased to accommodate slow networks 
 

Fixed 
AIR-18830 VE180 analytic correctly detecting loitering action 
AIR-20534 Axis: Symphony Client functioning correctly when zooming M3007 in quad view 
AIR-20613 Symphony correctly detecting Bosch Autodome 7000 HD camera 
AIR-20671 Symphony correctly receiving alarm from ADAM device  
AIR-20693 Vivotek camera disconnects and reconnects successfully 
AIR-20722 Add server from another farm feature working correctly 
AIR-20724 Client runs successfully after adding server to farm 
AIR-20732 VE180 configuration settings maintained correctly after upgrade 
AIR-20735 Backup restore process successfully restoring VE180 settings from before upgrade 
AIR-20736 PTZ Lock Message only appears when necessary 
AIR-20741 VE130 analytic correctly detecting motion in Axis corridor mode with dual stream 
AIR-20753 Footage file management improved for large scale systems 
AIR-20760 Log types labeled correctly in View Detailed Logs 
AIR-20764 ALPR working correctly in dual stream mode 
AIR-20775 PT091 autotracking corrected for dewarped image 
AIR-20776 Export to CSV working correctly 
AIR-20778 Timing issue with PTZ camera resolved, eliminating false motion detection issue 
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Fixed 
AIR-20790 Direct connect working correctly with Axis cameras 
AIR-20795 LPR installer completes correctly on Windows 2012 servers 
AIR-20799 Large import of cameras successful  
AIR-20800 Timeline working correctly for missed signals and disk full scenarios 
AIR-20801 Restore backup feature working correctly 
AIR-20802 Video wall switching working correctly 
AIR-20803 Successfully regains database connection after shutdown 
AIR-20804 Security profile switch messages correctly displayed when Clients restarted 
AIR-20805 Active Directory Single Sign-On correctly adding user to Symphony 
AIR-20806 Client runs successfully after Video Wall settings change 
AIR-20808 Manage Security dialog box correctly displayed on monitor 
AIR-20809 Correct permission message displayed for PTZ function 
AIR-20810 Security profile correctly activated so that user does not appear in Users Viewing 

Camera list 
AIR-20811 Videowall controller correctly connecting to videowall panels 
AIR-20812 PTZ lock functionality working correctly for camera in Direct Connect mode 
AIR-20813 Client runs successfully after maximizing/minimizing/closing/dragging videowall 

panels using videowall controller 
AIR-20814 Symphony successfully saves changes in User Configuration  
AIR-20815  
AIR-20816 

PTZ lock/unlock working consistently 

AIR-20817 Alarms for banned devices appear only when expected 
AIR-20818 Access Denied correctly for user from live ban group logged into client machine 

and adding cameras with Support Direct Connect enabled 
AIR-20825 New alarm entry in Alarm Log correctly added to log 
AIR-20826 Axis encoders setup as expected when added to Symphony 
AIR-20851 Resolution properly scaling to fit analytics resolution 
AIR-20865 License correctly updated after adding camera 
AIR-20872 Rules can be configured so that after motion is detected on a camera, auto 

tracking can be triggered on a second camera. 
 
Note: When entering a time value in the rule (force a PTZ camera to a location), if 
auto-tracking is selected, then the label of the rule now reads: Minimum seconds 
between activations of this rule. The PTZ camera ignores rule-triggering events 
for this many seconds. This prevents the camera from going back to the target 
position if the rule triggers multiple times. 

AIR-20881 Vivotek fisheye camera video displayed successfully on multi-view restore 
AIR-20883 Watchdog correctly restarting tracker when one of two streams on camera 

inaccessible 
AIR-20886 Client successfully updates automatically 
AIR-20983 Rule using fence activating alarm based on correct direction 
AIR-20955 Users Viewing Camera feature working correctly with Supervisor login 
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Fixed 
AIR-21049 AXIS P8221 audio issues resolved 
AIR-21056 Report counts correct for overhead people counting  
AIR-21060 In Turkish OS, PTZ lock/unlock message working as expected  
AIR-21061 Video Wall panel switching working correctly 
AIR-21067 Live video continues successfully when client loading new user 
AIR-21068 Clients upgrading correctly when servers are mixed versions 
AIR-21069 Client running successfully when Quick Find launched 
AIR-21138 Tracker working correctly 
AIR-21171 Gaps no longer appearing in timeline  
AIR-21179 RestartMediaGraph working successfully for restarted Axis camera  
AIR-21183 PT091 works successfully with dual streams when used with either VE180 or 

VE150 
 

Release 6.12.3.3 
(Not generally released) 

Fixed 
AIR-21015 Access to historical video after upgrade successful 
AIR-21021 NetSendHist no longer crashing 
AIR-21043 Footage indexes correct 
AIR-21045 PT091 working correctly 
 

Release 6.12.3.2 
(Publically released in 6.12.4) 

Fixed 
AIR-20938 Auto-tracking correctly starts when trigger by fixed camera 

 
Note: When entering a time value in the rule (force a PTZ camera to a location), if 
auto-tracking is selected, then the label of the rule now reads: Minimum seconds 
between activations of this rule. The PTZ camera ignores rule-triggering events 
for this many seconds. This prevents the camera from going back to the target 
position if the rule triggers multiple times. 
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Release 6.12.3.1  
New 
AIR-5322 Notify user if server farm becomes disconnected 
AIR-16632 Added ability for Symphony to stream RTSP 
AIR-18103 Support for Siemens SPC intrusion system 
AIR-19802 Online backup (only) now includes most recent one day’s worth of server logs. 

Stored in a logs.zip file. 
AIR-19951 
and  
AIR-20182 

Color detection analytics. See Analytics and Client User guides. 

 

Improvements 
AIR-19430 Contour-based object tracking 
AIR-20150 P2000 Integration  
AIR-20251 “Change Image” option for Maps now documented in Client User Guide 
AIR-20252 Symphony can connect with Gallagher server if Cardholder.FTItemID has a 

duplicate value 
AIR-20358 VE180 analytic engine will take advantage of multiple CPU cores if available 
AIR-20370 Alarm Counts report renamed to Alarm Statistics, and new report created called 

Alarm Report 
• Alarm Statistics - Summary (for example, per hour) of total alarms and 

how many are real-actionable, real non-actionable, and false 
• Alarm Report - A report on each individual alarm 

AIR-20371 SDK Rule Configuration sample includes Select Different Image option in analytics 
AIR-20523 VE180 and VE150 analytics now display the size/speed of an object. 

For calibrated cameras, size displayed in square meters and speed in meters per 
second. For uncalibrated cameras, size displayed in pixels/100 and speed is (pixels 
per second)/10. 
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10260  

AIR-20544 Better Taiwanese LPR support 
AIR-20557 Default configuration values in Advanced settings of VE180 analytic revised 
AIR-20607 Upgrade to TeamViewer v9 
AIR-20685 Support for v3.0 LPR dongles 
 

Fixed 
AIR-10793 ACTi: .aira video clip plays successfully in Symphony Player 
AIR-15735 
and  
AIR-19491 

Tracking boxes in correct location on cameras with multiple streams  

AIR-15930 Support for Chinese characters in Alarm Comments 
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Fixed 
AIR-16831 Joystick functioning properly after Client restart 
AIR-17025 Live audio default setting successful when Client set to Chinese Traditional 

language  
AIR-17310 Symphony Player successfully plays files with Chinese characters in filename 
AIR-18783 Symphony AD authentication correctly synchronized in multi-server environment 
AIR-18918 Symphony saves camera view layout filename properly by eliding unsupported 

symbols/characters 
AIR-19886 Add server from another farm feature working correctly 
AIR-19909 PTZ calibration successful on Samsung and Panasonic cameras 
AIR-20055 ACTi audio input working correctly 
AIR-20081 Video run back through Symphony successfully 
AIR-20092 Video clip exported at 1FPS (.aira file) plays at correct speed 
AIR-20143 Consistent video stream from Axis cameras 
AIR-20158 Historical video plays at normal speed when using RTSP 
AIR-20160 Status column updated correctly in Server Farm screen of Server Configuration 
AIR-20166 Errors no longer generated in Application Log when multi-view closed 
AIR-20167 VE180 does better job of tracking at low frame rates 
AIR-20181 Thai LPR collation fixed 
AIR-20185 Failover no longer occurs erroneously 
AIR-20188 Images copied to file or clipboard have correct colors 
AIR-20189 Web Client no longer prompts unnecessarily to install video plug-in 
AIR-20217 Thai LPR plate confidence now logged 
AIR-20219 Licenses no longer incorrectly allocated to non-camera devices 
AIR-20223 AXIS M3007 + P8221 audio works 
AIR-20227 Minimized de-warped quad view restored correctly 
AIR-20241 Windows 8 layout issues resolved 
AIR-20242 Apply To All button in the Other tab in Camera View Settings working 

consistently 
AIR-20249 Wall mount camera panoramic views corrected 
AIR-20283 Video decorations correctly displayed on webcam 
AIR-20296 Lock UI functionality restored 
AIR-20297 VE130 analytic able to find motion in small search areas 
AIR-20332 Correct access maintained when panel switched to blank camera while device 

tree loading 
AIR-20338 Clients authorized correctly after switching security profile 
AIR-20339 Symphony Messenger supports Chinese characters 
AIR-20375 Symphony Player installation process and launch successful  
AIR-20378 Search works properly with VE180 analytic 
AIR-20495 Adding cameras works faster 
AIR-20536 Symphony successfully recording and emailing when alarm on motion rule 

triggered and camera set to Never Record 
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Fixed 
AIR-20539 Do not send blank alarm e-mail 
AIR-20555 Calendar is correctly displayed in bold for the dates having footage and signal files 

available in   \Video\_footagearchive 
AIR-20579 Chinese characters displayed correctly in User Information dialog box, 

Description field 
AIR-20601 Rules trigger correctly on Flir and Axis PTZ cameras 
AIR-20605 Camera correctly defaults to record Always in case where analytic removed or 

analytic switched to a non-motion analytic 
AIR-20625 Lost camera connection alarm working correctly 
AIR-20635 Tracker marks timeline correctly when noting edge storage 
AIR-20296 User can successfully lock UI (View>Lock>Lock UI) 
Known Issue 
AIR-20725 Issue: 

During a server farm merge, DIO devices fail to merge properly. 
Workaround:  
After merging farms: 
Task 1: On the destination farm, delete the IO device manually. 

1. Server>Configuration> Server Configuration dialog box. 
2. Right-click on Devices and delete the IO device. 

Task 2: On the destination farm, add the device again. 
1. Server>Configuration> Server Configuration dialog box. 
2. New>Add a Hardware Device> <type of device>. Add IP address, etc.  The 

IO channels will be displayed. 
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Important: DevicePack and Export Feature 
Symphony Release 6.12.2.x requires Device Pack 1.0.10.0 for Export to work.  

Symphony 6.11.x (prior to 6.11.3) and 6.12.x releases earlier than 6.12.2 require device packs 
prior to 1.0.10.0 in order for export functionality to work. 

Symphony 
Release 

DevicePack Release Required Export Functioning 

6.12.2.x 1.0.10.0 Yes 
6.12.1 and earlier 1.0.9.x  and earlier Yes 
6.11.2 and earlier 1.0.9.x  and earlier Yes 
 

Release 6.12.2.1 
Fixed 
AIR-20199 InfoService correctly starts NetSendHist 
AIR-20215 Thailand plate descriptions functioning correctly in Aimetis License Plate 

Recognition (ALPR) 
 

Release 6.12.2 
Contains Device Pack 1.0.10.0 and Spanish and French Help. 

New 
AIR-19437 Generic de-warping functionality in Symphony, support for ENEO 5MP fisheye 

model. See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10250  
AIR-18947 Generic de-warping functionality in Symphony, support for Axis M3007.  

See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10250  
AIR-19942 JCI: support for metadata reception. Device Pack 1.0.9.0 or later is required for 

this functionality. See User Guides & Release Notes 
 

Improvements 
AIR-19473 SDK: instructions and sample code provided for How to wrap OCX into a DLL and 

use in an MFC Application.  
AIR-19474 Reports: Totals added to Object Crossing Line report 
AIR-19581 Improved accuracy in PT091 
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Improvements 
AIR-19583 Reports: New column includes object class 

New Columns for Object Counts Report:  
People, Vehicles, Unknown  

 
New Columns for Object Counts Across a Line Report:  
People In, People Out, Vehicles In, Vehicles Out, Unknown In, Unknown Out, 
Count In -> Renamed to Total In, Count Out -> Renamed to Total Out 

 
AIR-19587 Storage and cleaner performance improved 
AIR-19907 NAS storage performance improved 
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Improvements 
AIR-19939 VE180 – Analytics Configuration - Overview tab: Object Categories to Detect 

changed to “Classify each visible object as one of:”  Person, Vehicle, Unknown 

 
AIR-19945 Improvements to DevicePack deployment  

Also new important message in KB article: 
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10165  
 
When you install Symphony server, the _updates folder contains ONLY the Client 
Updates installer, not the DevicePack installer. Hence it CANNOT push DevicePack 
updates to clients.  

• If the client is a different version, it will push a CLIENT update which 
effectively updates the client's device pack.  

• If the client is the SAME version, it should have the same DevicePack 
version; hence no update is required. This means that if the client's 
DevicePack has been updated (or downgraded), the server will not 
automatically downgrade (or upgrade) it because it cannot.  
Workaround: If you install the SAME DevicePack on the Server, it will put 
the DevicePack client installer into the _updates folder and have no other 
real impact on the server. This will cause clients to update. 

AIR-20004, 
AIR-20005 

Various improvements resulting in customer benefits such as:  
• a slow disk will not result in missing footage 
• less expensive/slower storage (NAS/DAS/SAN/Local) can now work better 

with Symphony 
AIR-20031 SDK installer now includes C++ runtime components 
AIR-20061 Enhancements to Jacques IP intercom integration 
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Improvements 
AIR-20101 Aira2Mpeg utility uses existing encoding when exporting to .avi or when 

converting .aira to other formats resulting in faster exporting/conversion and 
without compression artifacts 

 

Fixed 
AIR-19447 InfoService restart correctly no longer triggers failovers 
AIR-19452 Heat Map Report generating result for correct stream in in correct location 
AIR-19518 Camera Tree and Map show correct states for ADAM device 
AIR-19621 Jpeg image correctly corresponds with historical video stream in two-stream 

scenario 
AIR-19795 Video Wall: Client connection maintained when creating 9 panel or larger multi-

view  
AIR-19832 Watchdog leaks resolved 
AIR-19891 Symphony Client works consistently after deleting multiple camera tours 
AIR-19893 Symphony Client works consistently after canceling add action for duplicate 

camera 
AIR-19911 Changing services account username with Symphony Manage Services dialog box 

correctly updating username 
AIR-19927 Importing CSV accepted with ports over 32767 
AIR-19930 Symphony Client works consistently when controlling PTZ camera with PTZ 

Control panel 
AIR-19932 Joystick functioning properly when cameras set to direct connect 
AIR-19934 Client DevicePack Update process – Clarification added to KB article: 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10166  
If an alert message indicating that a DevicePack with an older version number 
than the one already installed on the Client appears: If you have Clients that 
connect to multiple servers, you should manage your DevicePack updates 
carefully because a server with an older DevicePack might want to update a Client 
that has a newer DevicePack. This exists only for the purpose of intentional 
downgrades. 

AIR-19940 Client no longer continuously connects/disconnects under certain circumstances. 
See KB article: https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10251  

AIR-19947 PTZ lock working correctly in direct mode 
AIR-19952 Discover Devices no longer results in server disconnect 
AIR-19961 Images.zip no longer part of backup.zip files 
AIR-19991 Permissions consistent when switching from Symphony authentication to Active 

Directory 
AIR-20010 Camera Tree updated correctly on all clients 
AIR-20011 PTZ lock functions working correctly 
AIR-20013 PTZ indefinite lock working correctly 
AIR-20014 Video Wall layouts sorted correctly in alphabetical order 
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Fixed 
AIR-20015 Timeline in Symphony Web Client rendering correctly 
AIR-20016 Server Registration working correctly with SSO 
AIR-20017 Users Viewing Cameras dialog box shows correct user list 
AIR-20018 Informative and instructional error message now provided to user whose security 

profile has changed while attempting to add devices in the Camera Tree dialog 
box: "The action cannot be performed because the security or device model has 
changed. Please re-open the window to load the latest model, and try again." 

AIR-20020 Symphony correctly saving changed Polling Frequency in CPU Overload 
Protection of Server Farm 

AIR-20022 Device Tree Configuration dialog box functioning correctly 
AIR-20023 Alarm image correctly loaded  when clicking on new alarm in Alarm Log 
AIR-20024 View Detailed Events dialog box correctly displaying ALL events after user has 

clicked Yes to load more events 
AIR-20025 Symphony client functions correctly when user switches quickly between Add 

Another Tour button and other buttons 
AIR-20047 Device name change registered in Camera Tree within expected time 
AIR-20048 Video wall functioning correctly when switching panels 
AIR-20079 CSV imported camera list working correctly with redundant storage settings  
AIR-20087 Thailand plates supported in Aimetis License Plate Recognition (ALPR) 
AIR-20090 Alarm Log in Advanced mode context-menu option allows you to view the Alarm 

in the Main Camera View  

 
AIR-20099 MJPEG cameras showing correct colors in images 
AIR-20141 Security permission of Deny PTZ Control correctly displaying permission warnings 
AIR-20147 UPnP does not log errors. See KB article 

http://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10147  
Note: Windows Server 2003 does not support UPnP. 

AIR-20165 Images sent to File or Clipboard have correct colors 
AIR-20173 Offline and online backup successfully created 
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Release 6.12.1 
Contains Device Pack 1.0.8.2 and Brazilian Portuguese Help 

New 
New 
AIR-19544 Automatic upgrade feature for Symphony Client 

Now includes Symphony Client upgrades in addition to Device Packs 
See also KB Article: How to change download scheduling and speed for Device 
Pack and Symphony Client updates 

AIR-18646 360 cameras can be exported as de-warped view 
 

Improvements 
Improvements 
AIR-18834 Symphony now displays a message that not all ACTi camera resolutions are full 

field of  view 
AIR-18835 Symphony displays a warning message “Please refer to the device documentation 

for valid multi-stream configurations” on Network tab (Device settings) for 
cameras with restrictions on valid resolution/codec/frame rate combinations 

AIR-19109 Support for PT091 running on multi-core to avoid running out of CPU on a single 
core 

AIR-19170 Support for integrating 3rd party analytics into Symphony through the SDK 
AIR-19195 Symphony displays more than 120 days of footage on calendar 
AIR-19208 Improved performance from decreased CPU load on database 
AIR-19217 Reduced CPU load due to camera storage download requests 
AIR-19265 Grid spacing in VE130 analytic changed to improve motion detection 
AIR-19289 Sony: Symphony can now auto-discover Sony devices (Server 

Configuration>New>Discover Devices button) 
AIR-19358 Overload protection message now indicates which server has high CPU load 
AIR-19460 Support for floating-point FPS in Device Settings 
 

Fixed 
Fixed 
AIR-13012 Unhandled exception issue upon Rule creation resolved 
AIR-14400 Unhandled exception issue on ThreadPool resolved 
AIR-15169 Unhandled exception issue after modifying log level in Manual Configuration 

editor resolved 
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Fixed 
AIR-18772 Vivotek de-warp issues resolved: 

• Buttons displayed correctly when generating a report 
• Heat map with wrong tracking paths - if you change the camera resolution 

and see this issue, select a more recent image (with the camera 
resolution) 

• 3D person icons displayed correctly when increasing FOV to 180 degrees 
in VE180 analytic configuration 

AIR-18950 Rule Action, Rule tab modified: Rule list now as check boxes and “Restore state 
after motion ends” check box removed 

 
AIR-18992 Correct camera list displayed in Actions screen of Rule Wizard 
AIR-19014 User informed whether license old or expired when refreshing license from 

Aimetis.com 
AIR-19093 Old footage deleted correctly with Server>Delete Old Footage function 
AIR-19116 Connected subevents in Rules triggering alarms successfully  
AIR-19117 Hikvision: 6104 video server playback speed working in entire range correctly 
AIR-19136 FTP Action in Rule Wizard correctly sends all JPEG images to FTP server 
AIR-19177 License message correctly displayed in language setting of Symphony and OS 
AIR-19178 Event Logs contain user information when deleting a camera 
AIR-19190 All devices correctly displayed after restored online backup used after reimaged 

VM and reinstalled Symphony 
AIR-19202 Counting line displayed correctly after upgrade 
AIR-19210 Tracker synchronization process working correctly 
AIR-19270 VE352 recording on motion correctly. Also, VE352 now contains Tracked Motion 

Detected by PC option in Video tab, Record Video dropdown list. 
AIR-19292 Videowall: Resolved cross-thread exception error message when opening 

videowall through second Symphony client  
AIR-19297 Symphony functioning correctly when registering new video wall client in video 

wall designer 
AIR-19310 SDK User Guide updated: 
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Fixed 
https://www.aimetis.com/Library/Downloads/SDK_User_Guide.pdf  

AIR-19323 _signals2 file correctly rolling over every hour 
AIR-19334 Support for RTSP URL camera imported in CSV file with requested resolution 
AIR-19340 Correct number of Users Viewing Camera tabulated in client using Direct Connect 

during minimized and restored Multi-views 
AIR-19343 User can successfully view live video in direct mode from camera on down server 
AIR-19344 Symphony Client functions correctly when opening Video Wall manager after SQL 

server stopped and restarted 
AIR-19345 Symphony Client functions correctly (Maps feature) when database stopped 
AIR-19348 Remote Video Wall multi-view modified using Video Wall manager. Both clients 

running successfully after Video Wall manager left open for one day 
AIR-19364 View>Activity for Cameras time reference starts at midnight when dialog box 

first open or for a selected date 
AIR-19391 Exceptions in Rule Schedule saved correctly 
AIR-19405 SMTP port specification issues in General Settings resolved 
AIR-19406 Vivotek: FE8171 Panoramic view working correctly 
AIR-19418 HealthMonitor correctly starts only after detecting Phoenix device 
AIR-19421 Symphony correctly keeps unmovable device status after a manual attempt or 

automatic attempt to move device to a redundant server 
AIR-19444 FTP tab in Rule Wizard Action, Resize transferred file feature correctly resizing 

images 
AIR-19450 Historical retrieval working correctly with multi-streams 
AIR-19453 Changes to Reduce Reflection slider in analytic saved correctly 
AIR-19468 Changing PTZ Lock settings correctly logs event with username in View Detailed 

Events dialog box 
AIR-19479 View Detailed Events now shows more information about changes made to I/O in 

Key field 
• Added Groups/Devices  
• Edited Groups/Devices  
• Deleted Groups/Devices  
• Added Settings  
• Edited Settings  
• Deleted Settings  
• Edited DIO 

 
AIR-19488 Smooth video playback from Panasonic cameras with lower CPU usage 
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Fixed 
AIR-19489 JPEGS: Correct video image produced without artifacts of video data from 

another time segment 
AIR-19522 Validation check for potential URL redirection attack on port 50000 ensures users 

not redirected to wrong website 
AIR-19547 Symphony correctly listing which servers failed 
AIR-19556 
and  
AIR-19557 

I/O states correctly updated in Camera Tree 

AIR-19686 Client auto-update process successful 
AIR-19750 User prompted to restart machine in case where Windows Desktop Experience 

installed during a fresh Symphony install on Windows Server 2008, 2008 R2, and 
2012 (if not already installed on machine) 

AIR-19756 Disk reaching full capacity issue resolved 
AIR-19764 Alarm log in advanced mode successfully handles thousands of alarms 
AIR-19767 Client functions successfully with multiple maps and multiple items added to 

maps 
AIR-19769 Server license issues resolved 
 

Known Issue in 6.12.1 
Server Farm 
AIR-19886 Issue: Adding a server to a farm in Server Configuration is temporarily non-

functional.   
Workaround: Use the Setup Wizard.   
Scope: This only impacts users who want to create multi-server farms. 

Release 6.12.0.1 

Fixed 
Fixed 
AIR-19271 Search functionality 
AIR-19273 Redundant storage 
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Release 6.12 

New 
New 
AIR-12959 Support for Bosch Dinion camera I/O ports in Maps and Device Tree 
AIR-13920 New simple and robust online and local backup and restore functionality – Full 

instructions in Symphony 6.12 Administration Guide 
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New 

 
 
Troubleshooting: 
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10212  

AIR-15101 New camera movement compensation VE101 engine (BETA Release). No 
configuration required. Enterprise license required. To be used with VE150 or 
VE180.  
For an outdoor surveillance camera that is moderately shaken (such as when 
attached to a pole on a windy day). 

• VE101 incurs a large CPU penalty. To reduce CPU and storage utilization, 
no output of the stabilized video feed will be available – stabilization is 
run “live” in memory - frames are passed to the other analytics and then 
discarded.  

• The other video engines (VE150 or VE180) will run with delayed video 
(obtained from the video stabilization output), even if the live view is in 
real-time. Therefore, the tracking boxes will appear delayed about 1.5 to 
2 seconds. The video engine’s boxes around moving objects are stabilized, 
but the rendered video itself is not.  Therefore the boxes may not line up 
exactly with moving objects. 

• We always recommend fixing the core issue, if possible, by physically 
attaching the camera to something stationary under all weather 
conditions.  
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New 
AIR-18133 
and 
AIR-18518 

Read/write to multiple storage locations, failover recording – Availability section 
in Server Configuration>Storage   

 
 

Improvements 
Improvements 
AIR-11947 Users can modify Analysis Resolution in VE130 
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Improvements 
AIR-13555 Option to select different image for Heat Map report added 
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Improvements 
AIR-16417 VE180: Mouse wheel perspective control 

Allows you to control the amount of perspective in the scene without changing 
the overall scale.  (Allows you to make a person icon a certain size while changing 
the Field of view so that the tilt of the other people icons and their relative size is 
correct.) 
 
Position the mouse over the little diagram. Rotate the mouse wheel to increase 
or decrease the Field of view in 2.5 degrees increments, creating an opposite 
proportional change in the ground distance parameter. 

 
Example: Ground distance is 10.0 meters and the Field of view is 60 degrees. One 
mouse wheel click changes Field of view to 62.5 degrees and ground distance to 
(60/62.5)*10.0 = 9.6 m. A mouse wheel click in the other direction changes Field 
of view to 57.5 degrees and ground distance to (60/57.5)*10.0 = 10.43 m. 

AIR-18699 Aimetis Physical Security Appliances (PSA): Customer warned when upgrading a 
PSA manually potentially to a release that has not been certified for the PSA 

AIR-18831 Support for viewing video and PTZ control from IP cameras connected to JCI 
DVN5000 NVR 

AIR-18976 Support for HikVision cameras in direct connect mode 
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Improvements 
AIR-18981 New Follow focus option in Sound tab of Client Settings. Keeps sound setting 

when panel focus changed. 

 
AIR-19065 JCVS-IP2352422, JCVS-IP3352445, JCVS-IP141132336, and JCVS-IP1012211 

cameras (supported as of Device Pack 1.0.6.1) are now auto-discovered with 
Symphony 6.12.  

 

Fixed 
Fixed 
AIR-11595 Leaving rule option (rule to trigger when an object is detected within a masked 

area and then object leaves masked area) has been removed from VE180  

 
AIR-14449 OpenCL support has been removed since Microsoft does not let services interact 

with the GPU 
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Fixed 
AIR-16465 ALPR: Changing date correctly updates License Plate log 
AIR-18176 Resolutions from 2nd stream in resolution range supported by the video analytic 

engine 
AIR-18275 Video export from Client working correctly when server and client in different 

time zones 
AIR-18520 Can successfully add server to farm 
AIR-18534 Adding camera does not require Client restart after IP address of server changed 
AIR-18551 PTZ camera correctly returns to Home position after unlocked by user 
AIR-18659 Failover on multi-server farm: showing correct number of cameras on servers and 

correct number of redundant servers 
AIR-18678 
and 
AIR-18680 

Importing large number of cameras successful 

AIR-18683 Client on one machine accurately updated when changes made to same client 
running on another machine 

AIR-18686 Quick Camera Setup dialog box from Camera Tree context menu appears only if 
user has Device-Change Settings permissions. 
Camera Setup context menu visible in Camera Tree only if user has Farm-Change 
Settings permissions. 

AIR-18704 Rule icon color on Maps can be changed successfully 
AIR-18742 Videowall generates error messages as expected when user tries to change a 

panel with an incorrect panel name or when the Client is not running 
AIR-18766 Pre Event and Post Event fields for 2nd stream now contain default value of 15 
AIR-18870 Heat map report generated correctly  
AIR-18922 ONCAM: PTZ mouse control working reliably 
AIR-18923 Alarm Statistics report generated successfully with cameras from different 

servers 
AIR-18942 Hikvision: DS-6500/DS6516 encoders correctly auto-detected by Symphony 
AIR-18946 Rule Wizard – Sub events must occur option:  rule alarming correctly on sub 

event 
AIR-18962 General Settings interface clarification – Frame Time Deviation now correctly 

reads as Frame Rate Variance. See also 
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10219  

AIR-19000 SNMP walk command successful when setting SNMP Retries to 2. Instruction 
added to Administration guide: SNMP using UDP, set SNMP Retries to 2.  (Using 
iReasoning MIB browser, for example, Tools>Options>General tab, SNMP 
Retries=2 field.) 
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Known Issues 
Sound 
AIR-16867 Release 6.9.5, 

6.10 
Playing audio files via Rules does not work when using Server 2008 
R2/Windows 7/Windows Vista 
 
Workaround: 

1. Download “psexec” online 
 (http://technet.microsoft.com/en-us/sysinternals/bb897553.aspx) 

2. Setup AI Scheduler service to login as a user that has 
previously logged into the server interactively. 

3. Setup the computer to  automatically log in on bootup as 
the same user that is logging in AI Scheduler. 

4. Create a playsound.bat batch file (all one line): 
 
Example 
psexec.exe -i 1  
C:\Program Files (x86)\Aimetis\Symphony\_bin\schedulerplayer.exe play 1 0 
c:\windows\media\chimes.wav 
 
psexec.exe –i <session to run program in> <path to 
schedulerplayer.exe> play <number of times to play> <delay> 
<path to audio file to play> 

5. The key “–i 1” must specify the interactive session number 
for the process to run in.   

a. To get a session number, run procexp.exe and turn 
on the session# column. 

b. Look at the session number for a process running 
as the logged in user. This is probably always 1 on a 
Windows installation with a logged in session; 
therefore “-i 1” should always work. 

6. Create a rule action similar to the following: 
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Cardax Integration 
AIR-16857 
Renumber
ed as 
PACK-254 

Release 6.10 User must repair OPC Bridge Configuration Version 6 from Cardax after 
Symphony upgrade 
Installing OPC Bridge Component 6.1.0.5 and the OPC Core Components 
Redistributable software pieces are required for Cardax Access Control. 
The OPC Bridge Component stops working after a Symphony server 
upgrade. 
Workaround: 
If you have OPC Bridge Configuration Version 6 from Cardax installed 
you must repair it after upgrading Symphony by re-running the OPC 
Bridge Configuration installer. 
 

 

Camera 
AIR-12315 
Renumbered 
as PACK-254 
 

Release 6.5 
 

Support latest Mobotix Firmware for VMD of camera 
 
VMD from Mobotix cameras is working only on devices running Fw. 
3.4.09 (from 2008). With the Fw. 3.5 and 4.x (running on all new 
models like M24, D24, Q24) it is not possible to use this functionality. 
Renumbered as PACK-254 
See DevicePack Release Notes 1.0.6.0  

AIR-12896 
 

Release 6.6 
 

When adding Axis 241Q, only the first channel has default codec set 
Camera 
When adding Axis 241Q and other multi- channel video servers, such 
as Hikvision 6104), and clicking the Connect to Camera button, only 
the first channel has the default codec settings. All others channels 
have a blank codec. 
Will not fix. 

AIR-15613 Release 6.9 Multi-lens cameras require one license 
If you select a multi-lens camera, multiple licenses will be required. 
You must contact Sales to be given the difference of licenses, for free. 
This problem is typically only with Arecont cameras. 

 

Interface 
AIR-12409 
Renumbered 
as PACK-175 

Release 6.5 Vivotek FD8361 crops image in stream 2 and displays stream 1 
when navigating away from camera 

 

Documentation 
AIR-19192 Release 6.12 6.12 HELP missing some VE180 interface changes. However, information 

is up-to-date and correct in the Aimetis Symphony 6.12 Analytics Guide. 
 
Resolved: 6.12.1 HELP updated 
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LPR 
AIR-17540 Release 6.10.1 When LPR installer prompts user with message regarding gxsd.dat file, 

user should select No. 
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